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TIPS Carlson Software 2012 Installation Instructions

Getting Started

® All TIPS software users must install the latest KeyServer Client on their machine prior to
installing new software versions. This is a requirement of the TIPS program to allow for
adequate collection of license and server usage statistics. The latest KeyServer Client is
available on the TIPS website http://www.tips.osmre.gov/Software/Downloads.shtml.

® Before starting the installation process, you will need the following:

» TIPS Carlson Software 2012 DVD or download from the Carlson website at
http://update.carlsonsw.com/updates.php; you will need to enter the Carlson software
serial number to ‘Lookup Download’ and access the latest full install file (i.e., Full
version Carlson 2012 dated 11/03/2011 or later.).

» Serial number, hosts file, and environment variable information provided with the OSM
TIPS distribution.

» Administrator credentials are required for program installation and first run of Carlson
2012.

» Though the vendor reports that it is not required, we recommend that the end user also
have administrator credentials for the software to function most efficiently.

General Overview

In order to properly install Carlson Software 2012, you must do the following:

1. Install and launch the AutoCAD Map software prior to installing the Carlson product. If
Raster Design will be loaded on the user machine, it is required that it be installed and run
once also prior to installing Carlson 2012.

2. Use the instructions below to install Carlson Software 2012. These instructions are based on
installation onto AutoCAD Map 3D 2012 but can also be applied to installation on previous
versions of AutoCAD Map.

3. Ensure that the environment variable LSHOST and the HOSTS file are set according to the
documentation provided with the TIPS distribution notification. Note that if a previous
version of TIPS Carlson or SurvCADD software was installed, the required settings will have
already been applied (see page 20 for details on accessing the environment variable).

4. Launch Carlson Software 2012 while logged-in with Administrator credentials in order to
complete registration and automatically check for and install current updates. Current
updates can be accessed directly by visiting http://update.carlsonsw.com/updates.php; you
will need to enter the Carlson software serial number to ‘Lookup Download’ and access the
available update file(s).

5. Have the end user log-in and follow the detailed instructions to set the default ‘AutoCAD
Map Classic” menu and restore ‘Express’ and ‘Raster’ menu dropdowns (See instructions on
pages 14-19).

@ If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or
TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Stefanie Self at (412) 937-2105
or SSELF@OSMRE.GOV.

Additional information (e.g., most recent installation instructions and installation FAQSs) is available on
the TIPS webpage http://www.tips.osmre.gov/Software/cad/CAD.shtml.



http://www.tips.osmre.gov/Software/Downloads.shtml
http://update.carlsonsw.com/updates.php
http://update.carlsonsw.com/updates.php
http://www.tips.osmre.gov/Software/cad/CAD.shtml
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Initialize Carlson 2012 Installation

e You must have Administrator credentials to perform the installation (i.e.,You must be logged-in
as an administrator).

e If you have the TIPS Carlson Software 2012 disk, insert it into the appropriate drive. If the
installation does not start automatically, browse to and double-click on the DVD drive; if that
fails to launch the installer, navigate to the root directory of the DVD and double-click
‘Autorun.exe’. This opens the ‘OSM TIPS Carlson Software 2012 Installation DVD”’.

e Click on Install Carlson 2012 to initialize.

e It may take 45 seconds or more for the installer to load and initialize (If the installation fails to
initialize after a minute or so, navigate to the DVD root directory and double-click on the
installation file ‘InstallCarlson2012.exe’ to install.).

OSM TIPS Carlson Software 2012 Installation |

Click on Each "Radio Button' ta Initiate the Conresponding Action.
You Must Be Logged-In with "Administrator” Credentials to Install the Software.

Adobe Acrobat Reader iz Needed to Dizplay the Documents on This WD,

About This DVD D!sp!ay I_nformation About This DVD
Distribution.
b g g q
. . Dizplay the 05SM TIPS Installation Instructions
| Installtion InSuetons | foy Carson Software 2012 [ersion 1302012, |

Dizplay the Carlzon Software 2012 Manual
Earlson 2012 Manual [Versian 15.2011),

’/"ﬁ“ O'r nstall Carlson Software 2012
ﬁl '”S'a" Carson 2012 [Full Version 11-3-2011 7 Build 111103).
|,.; i
Instructions to R estore AutoCAD R aster Design
9%} IRty Dleslmp e (A ‘Raster' Menu on Carlson Software 2012 I
mmc‘/

or
e If you obtained the software via download, navigate to the location where the full version EXE
file was saved and double-click on the file (i.e., Carlson2012.exe) to initialize the installation
program.
e The Carlson 2012 installation process will initialize... (Note: If an “Open File — Security
Warning” or “User Account Control” window appears, click Run or Yes and continue.)

==

- InstallShield Wizal

|| g Carlson Setupis preparing the InstallShield Wizard, which wil
quide you thiough the rest of the setup process. Please wait

Cancel
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Click Next to continue with the installation.

Welcome to the InstallShield Wizard for Carlson 2012

el

InstallShield Cancel

License Agreement
Flease read the

Diownload the original attachment

Licenze Agreement

Copyright 1932-2011 Carleon Software &l Rights Reserved
CAUTIOM! READ THIS NOTICE BEFORE USING SOFTWARE

Pleaze read the following Software License Agreement before using the SOFTWARE. Using
thiz SOFTWARE indicates that pou have accepted its terms and conditions.

Carlzon 2012
EMD-JSER LICEMSE AGREEMEMT FOR CARLSOM SOFTWARE
IMPORTAMT-READ CAREFULLY: This Carlson Software End-User License &greement

["EULA"] iz a legal agreement between vou [gither an individual or a single entity] and Carlzon
Software, Inc for the Carlzon SOFTWARE accompanging this EULA, which includes
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e Select the applicable platform (i.e., 64-bit or 32-bit) version that you want to install (in this case,
click on the circle next to 64-bit version of AutoCAD...).
e Click Next to continue.

Select platform to use

Cancel

e Select the version of CAD software that you want to use with Carlson 2012 (in this case, click on
the circle next to AutoCAD / AutoCAD Map 2012).
e Click Next to continue.

Select CAD version

< Back k Hext » ’ Cancel

el




1/30/2012 Carlson Software 2012 Page 5 of 21

e Enter the Serial number provided with the distribution.
e Click Next to continue.

Get Serial Number

ftwaare in order to continue.

’ < Back (ﬂiﬂb D

il

Verify the install path. The default ‘C:\Program Files\Carlson2012_ACAD12_Xxx’ is
recommended.

e Use Browse to change the default location if desired.
e Click Next to continue.

ct another

Browse...
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Choose the preferred Setup Type:
‘Complete Install’ copies all files to the user computer.
‘Remote Install’ copies some files to the user computer and some to a network server.

The ‘Complete Install” option is recommended (The ‘Remote Install’ option has not been tested
and is not supported by TIPS.).

Click Next to continue.

Setup Type

up wou prefer.

< Back ; Mest > ’ Cancel

— el

Verify the Carlson work directory. This is where the program will store drawing and data files
by default. The default ‘C:\Carlson Projects’ is acceptable.

Use Browse to change the default location if desired.
Click Next to continue.

Select Work Directory

nd data files

Browse... |

Caneel
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Verify the project settings directory. The default ‘C:\Carlson Projects\Settings’ is recommended.
Use Browse to change the default location if desired.
Click Next to continue.

Select Settings Directory

t & directony to be used by default to

Review the information in this dialog box to ensure that all settings are as desired.
If changes are needed, click Back to revert to the appropriate screen(s) and revise as necessary.
Click Next to continue.

Start Copying Files
A .

Froduct version: Carlzon 2012 with AuteCAD 2010-2012
Madules selected: Bazic Carlson 2012
Survey
Civil
Geology
Hydralogy
B azic Mining
Underground Mining
Surface Mining
Field
Point Cloud

Matural Regrade
Inztall type: Full install
Carlson 2012 Directory: C:\Program Files\Carlson2012_ACAD12_<64
Prograrn Directory: C:%\Program FileshCarlzon2012_ACADT2_XE4ALSPY
wiork Directory: C:ACarlgon Projectsh
Exec Directory: C:\Program FileshCarleon201 2_ACADT 2_<B4\EXECH

4

Cancel
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e Enter an optional CAD profile if the user or your office has specified one.
e The default (i.e., leave blank) is recommended.
e Click Next to continue.

Get Profile Mame

e optional CAD prafile name to copy fram. Leave blank

roric [

InstallShield Catcel

e The installation will progress with files being copied...

Inztalling ‘

CA ASupTemplatetics11baze dll

S ﬁ Instaling

C:hCALSPACFG_SCAD fas

Cancel

’ Inztalling ‘
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e When prompted, select the version of the Autodesk product that you would like to start with
Carlson 2012 (in this case, AutoCAD Map 3D 2012). This is dependent on what version of
Autodesk software is installed and was specified in the step at the bottom of page 4.

e Click Next to continue.

Select AutoCAD

you would like

oCAD Map 2D

[ < Back ( Hesxt » )

e The installation will continue with additional files being copied...
e After file copying is complete, ‘Support and Updates information” will be displayed.

e Click Next to continue.

Support and Updates information

the: followir

InstalIShield Cancel
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¢ Click Finish to complete the installation.

InstallShield Wizard Complete

Double click on icon on you

Cancel

e Click Finish to close the ‘OSM TIPS Carlson Software 2012 Installation DVD’.

e You may also want to close the DVD folder used to initiate the TIPS DVD installation routine
and / or ‘Exit’ any command window that may be open.

OSM TIPS Carlson Software 2012 Installation |

Click on Each "Radio Button'' to Initiate the Comesponding Action.

You Must Be Logged-in with “Administrator' Credentials ta Install the Software.

Adobe Acrobat Reader iz Meeded to Display the Documents on This DVD.

Ahout This DVD Display |nfarmation About Thiz DVD

Diiztribution.
i . . .
: : Dizplay the 05k TIPS Installation [nstuctions
| Installation Instrucions 7 i Sl s A2 e -2 D20 )

[ergion 3-15-2011).
_f% Install Carlsan 2012 Inztall Carlzon Software 2012
-u| 2 : Ingtructions to Restore AutoCAD Raster Design
FleRiey Dt = ‘Raster' Menu on Carlzon Software 2012 ]

[Full Version 11-3-2017 # Build 111703].
.i'umff}/ |

Carlson 2012 Manual | Display the Carlzon Software 2012 kManual
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Launch Carlson 2012 / Program Updates / Registration

Note: Before launching Carlson Software 2012, you must set the environment variable LSHOST
and the HOSTS file according to information provided with the TIPS distribution package. If a
previous version of TIPS Carlson software was installed, the required settings will have already
been applied. (See page 20 for details on accessing the environment variable.)

While still logged-in with Administrator credentials, launch Carlson Software 2012 from one of
the Carlson desktop shortcuts or from the MS Windows Start Menu.

- . Carlson Software
. Carlson 2010 with AutoCAD Map 3D _
. Carlson 2010 with IntelliCAD 6.6 1
. Carlson 2011 with AutoCAD Map 3D
>4 | Carlson 2012 with AutoCAD Map 3D
oo s [P Carlson Civil 2012 with AutoCAD Map 30 2012 |
|8 Carlzon Field 2012 with AutoCAL
‘ Carlson Hydro 2012 with AutoCE
W Carlson Mining 2012 with AutoC
@ Carlson Natural Regrade 2012 wi
B Carlson Point Cloud 2012 with A [ TSR iy

rrrrrr

Network

Control Panel

| Carlson Projects
/W Carlson Survey 2012 with AutoCs [SEEIEIEREENS
B3 Check for Carlson 2012 Updates
T3 Reset User Profile Help and Support

Back

The program will automatically check for main program updates upon the first run and thereafter
when the program is run (via internet connection).

If updates are identified during this process, it is recommended that they be downloaded and
installed to ensure that the most current features are available to users. Simply follow the screen
instructions to accomplish this.

If users do not have Administrator credentials, consider selecting the box next to ‘“Never check
again’ as non-Administrators would not be able to install future updates identified by the
program.

If no updates are available (as shown below), click Exit.

" Carlson Software Update Wiza

Connecting to Carlzon update server...

Mo update available, <=

Click Exit button.

Mo update iz available.

Click Exit to finish...

=22 [ Mever check again Options
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AutoCAD Map 2012 / Carlson Software 2012 will proceed to open.

Note that the AutoCAD Map ‘Welcome Screen’ will first appear if it has not previously
been disabled. You must wait for the Carslon registration process to complete and for the
Carlson ‘Startup Wizard’ to appear before you can close the ‘Welcome Screen’.

The Carlson registration process will complete.

Click OK to continue.

Carlson Software Message ﬁ

Registration Completed

(GTIND)

The Carlson 2012 ‘Startup Wizard’ window will open as a default. Click EXxit to close the
window and continue the software start-up.

Note: The ‘Startup Wizard’ will not appear if the user had previously altered this setting and the
installation included copying the settings.

Draw  Inquiry  Settings Points Window Help Survey ! Centerline Area/layout  Annotate  Surface

% Task Pane

Current Map: Default -

oo sye Tove toos [ o8 3 &5 & &y I [l o & £ ]
‘ £Z Draw Order | g
- Map Base g E:S
O Default & r’
o (i)
=
?'1 rStartup Wizard ﬂ
i Recent Files
=3
-§ .
A 5
= H Preview
=]
i =
A
Iy
c
A
Open Recert File [7] Skip Startup Wizard Next Time
P —
OpenAnctherFle | [ New ([ Ba | [) Hep |
T
|

Carlson 2012 will continue to open.
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e Once the program opens completely, you can then close the AutoCAD Map ‘Welcome Screen’
by clicking on the “X” in the upper right corner...

u‘.‘anh‘AD ICRD: NOHE  Drawingl.cwg

o

Magp Hzlp File Edt  View Create Modify  Analyze Sewp Virdow Helgp Fie Edit  View Creste Modify  Analyze  Setup Wirdo
FHome Incet Output Home  Fzawure Map Edi Feature Cbject Map  Edit Coject JAnnctate View Tools Farametrc Map Setup  Create Home

A AVB/c SIANLARY = I‘ " S1ANDAED - ~Z  Standed - Stardarc - 2 (("))
Eme— (i J i z A4 4 40 %0 o . || .
Multine =~ Check ——— | Dimenson b Tl I - A A Multileader /°2° %8 /8 Table P P P B Wipeout Revicior | Ad
Tet Spelling 400 - = Cloud
Texl « 3| Dirnenams « 3 | eadders 3| Tables ol Mot L '
TS ol =& O O Ly r’ﬁ.‘ Welzomne tcraen = D . - [——
£ (5 (s e 1~ X QPR ometerzen ® 1" r e -C

Getung Started Videos

Video 1: Introduction fo AutoZAD Mip 3D 2012

Valen 2: Gelling Shesleed wills Ihes Plaseiing aml

Analynis Weorksjace &

Video Z: Hanning and Analysis Workpace
Cssertial Skills

Video < Getting Sterted with the 2D Drafting
Workspace

Video S: 2D Drafting Workspzce Essential Sklis

v
Video €: Getting Started with [njustrr Modes
X - ]

IRIDD] ‘\_ '( Lot / ) Vilen 7: Manlenan: e Wenkspione Faoerlid Skis 88 > e —
= - —
B Copyeighl {e) 1933-2811 Cer S

Cuntomizat ion Cil= Tomded ~uc: g What's Now? | Learning Path
(Cuslomizat ion Fil= Toaded Soc:y

Contumizat for Cil= Toaded ~ucid AutoCAD Map 3D Help | More Vidoas
Customizatior fil= loaded succ
Customizatior fil= loaded succe
Customizatior fil= loaded succ Show this dialoq at startup
Customizatior fil= loaded succa

e If the User is already logged-in (i.e., as the Administrator), proceed to “Set ‘AutoCAD Map
Classic’ Menu:” on page 14.

e Go to the ‘File’ menu dropdown and click Exit to close the program (Click No when prompted
to save the drawing file).

' Cet
Maf | o Digw Phsrhne pubisn vetaus...

Task Drawing Utilities i’

CUrre Send...

|:' Drawing Properties...

Q Drawing History
Data

Exit Ctrl+Q
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Launch Carlson 2012 as the End User and Set Program Defaults
e Have the end user log-in.

e Have the user launch Carlson Software 2012 from one of the Carlson desktop shortcuts or from
the MS Windows Start Menu.

C

Carlson
Natural Re...

g | Carlson Software
I, Carlson 2010 with AutoCAD Map 3D _
| Carlzon 2010 with IntelliCAD 6.6 1
| Carlson 2011 with AutoCAD Map 3D
| Carlson 2012 with AutoCAD Map 3D i
w= Carlson Civil 2012 with AutoCAD Map 3D 2012 §
[ Carlson Field 2012 with AutoCAL
& Carlson Hydro 2012 with AutoC£
#® Carlson Mining 2012 with AutoC
M Carlson Natural Regrade 2012 wi
-’ Carlson Point Cloud 2012 with A Devices and Printers

Downloads

Network

Control Panel

', Carlson Projects
B Carlson Survey 2012 with AutoCs [SEEIEIIEEES
B3 Check for Carlson 2012 Updates
B3 Reset User Profile Help and Support

nd files

e |f the Carlson update screen appears, click Exit.

e Wait for the Carlson 2012’ Startup Wizard” window to appear; click EXit to close the window
and continue the software start-up (Note that the ‘Startup Wizard’ will not appear if the user had
previously altered this setting and the installation included copying the settings.).

e Carlson 2012 will continue to open.

e Once the program opens completely, you can then close the AutoCAD Map ‘Welcome Screen’
by clicking on the “X” in the upper right corner.

Set ‘AutoCAD Map Classic’ Menu:

e Set/ verify that Carlson 2012 is set to open to the ‘AutoCAD Map Classic’ menu.
e Select the ‘Settings’ menu dropdown and click on Carlson Configure...

- . Zalls_gn_ﬂll with AD - [CRD: NOME]
b 8 "

I it ew raw
Map Help File Edit  View

ENGIEIC Home  Insert Output Home iect/Data Folders

STANDARD “  Carlsen Configure
Settings Explorer
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e Click General Settings...
-
Configure ﬁ
é General Settings... } l Drawing Setup... ]
[ Project/Data Faolders ... l [ Startup Settings ... ]
[ Survey Settings. . ] [ Surface Settings.. ]
[ Section-Profile Settings... ] [ Hydrology Settings... ]
[ Mine MNote Settings... ] [ Mining Settings... ]
[ Takeoff /SiteMet Settings. .. ] l Localization Settings... ]
[ Bit || Hp || Load || savess |
]
o Verify / select AutoCAD Map Classic as the setting for ‘AutoCAD Menu.’
e Click OK to continue.
rGeneraI Settings r - . » e l ﬂ
General Object Linking Coordinate File Format
Use Startup Wizard [T Link Points with CRD File () Carlson Numeric Only
["] Generate Report Log (] Link Linework with Poirs (@) Carlson Alphanumeric
Save Drawing INI Files () Cand G Numeric Only
lgnore Zera Hlevs [ Link Labels with Linework
[ Use South Azmith () Cand G Alphanumeric
[ Link Linework with Centerines e
Use Dview Twist Angle () Simplicity ZAK
[¥] Set DIMSCALE to Drawing Scale [¥] Group Point Entities () MS Access Database (LDT)
Set AUNITS to Drawing Angle Mode [ Mairtain CRD Histary File Remove Arcs
[7] Set PDSIZE to Symbol Size e —— Method By..
[¥] 5et INSUNITS to Unitless @) Max Offset () Chord Len
ie{ LTS:;»‘\LE on stacl;tup t;lf)dm.\n\ring Setup ) Aocess 97 © Access 2000 Max Offset 0.00010000
orce software-only Open river Chord Length
Coordinate Report Order Digtizer Seftings
Formatted Document Type PDF - Digitizer Puck Layout View
Report Viewer Auto Tablet On For Digtize Commands
AutoCAD Menu AutoCAD Map Classic - [] Auto Tablet Cff After Digiize Commands
e
—
e Click Exit to close Carlson 2012 configuration.
r hl
Configure CX
[ General Settings. .. ] [ Drawing Setup... ]
[ Project/Data Folders... ] [ Startup Settings... ]
[ Survey Settings... ] [ Surface Settings... ]
[ Section-Profile Settings... ] [ Hydrology Settings... ]
[ Mine Mote Settings... ] [ Mining Settings... ]
[ Takeoff /SiteMet Settings... ] [ Localization Settings... ]
—
( Bt D[ Hep || load || Saveds |
>
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Restore AutoCAD Express Tools and / or Raster Design Menus

e Launching Carlson 2012 using the program ‘Start’ menu or desktop shortcuts will set AutoCAD
with Carlson 2012 to open minus the ‘Express’ (i.e., Express Tools) and / or ‘Raster’ (i.c., Raster
Design) dropdown menus [The ‘Raster’ menu is only applicable if Raster Design has been
installed.].

e Once the menus are restored per the steps below, the settings will be preserved. The ‘Express’
and ‘Raster’ menus will be included no matter what program shortcuts or ‘Start’menu item is
used to open AutoCAD Map / Carlson 2012.

e Change to the AutoCAD Map menu by clicking on the ‘AutoCAD’ menu toolbar icon or
‘AutoCAD Menu dropdown.

Tyvpe a keyword or phr

Annotate Window Help Insert E Drawing Setup

Set Project/Data Folders

EULLEEN Home Home  Surface  Home Mesh  Output  Output  Parametric  Render View  Vie

D H (&6 O KO BE Y Coton Configue YL (EXY T2 I T
7 Settings Explorer —
Current Map: - - Settings File Manager Open the AutoCAD Map menu by
g AutoCAD Options clicking on the AutoCAD toolbar icon
9 % 25 - Treailies (as indicated above, right) OR by
o = @) Sl selecting Settings >.C:?rlson Menus >
e e e e = [= Layer Library AutoCAD Menu (as indicated left /below)
2
@ | £Z Draw Order _ 'S Quick Keys
%';‘;‘;‘Carlson Menus 3 * Survey Menu
- Map Base o
| N Title Block B | Chil Menu
Default
| au ,E- & Mortgage Block & Hydrology Menu
& . &) GISMenu
P Rescale Drawing
. 78  Construction Menu
_ @ Crosshairs 3
=% Tablet Calibration 3 9 Vel
=~ Create AutoCAD Icon & e
é f Point Clouds Menu
é" ]§£ flod=lecan) @ Matural Regrade Menu
H Rt } Basic Mining Menu
| | 5 Point Object Snap On/Off R Geology Menu
ndergreund Mining Menu
E Object Snap ' Underg 4 Mining M
0A Pickbox-5elect Settings :o Surface Mining Menu
5] ystem Variable Editor
o System Variable Edi
a =y Point Style somom Mt AutoCAD Menu
% Grips Menu Language Translation

e Note the resulting ‘AutoCAD Map Classic’ menu list.

e If ‘Express’ and ‘Raster’ are not included as menu dropdowns, they must be restored.

e Note: The ‘Express’ and ‘Raster’ menus may not appear in the same position or order as shown
in the screen capture below.

Surface Home Render Insert Inset Manage Mesh Output Output View  View

/ 05» A gﬁ\ l_/‘l_t] il [

‘Express’ Menu:

e To restore the ‘Express’ menu, simply enter ‘expresstools’ on the program command line and
press ‘Enter’ (i.e., type ‘expresstools’ and press the enter/return key.).

& X
IEIDCIN A Layoutl /
L, 20|~ 3D |Vertical Exaggerstion: |1x | = | Command -
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‘Raster’ Menu:

e Restoration of the ‘Raster” menu is necessary only if AutoCAD Raster Design 2012 has been
installed. If Raster Design has not been installed, proceed to page 19.
e Enter ‘cuiload’ or ‘menuload’ on the program command line and press ‘Enter’.

L x

] 4] o]y { Layout1 / Layout2 /

1. 20 L~ 3D|Verical Exaggeration: [1x | ~ | Command ||

¥ Command: COMMANDLINE —
Command: _MRPSTARTWSPACE

Command; cuiload

1L | [D]0] =1+ 0] 8 [

e Use ‘Browse’ to navigate to the DVD drive root directory (a copy of the ‘Raster’ menu file
‘AecCo.cuix’ is located there.).

¢ Note that the file can also be found in the AutoCAD Raster Design 2012 program ‘Support’
folder (The default path would be ‘C:\Program Files\Autodesk\AutoCAD Raster Design
2012\UserDataCache\Support\AecCo.cuix’.).

A‘;"n' Load/Unload Customizations &

Loaded Customization Groups:

MAPCLASSIC

File Name:

e From the DVD root directory, highlight / select the file ‘AecCo.cuix’, and click Open.

r 3
’!‘D' Select Customization File R [&J
'y
Look in: ’ﬂDVD Drive (E:) Carlson2012_111103 v] | (B b4 ﬂ' Views ~ Tools
MName ’ Date medified Type
I ’ . AboutThisDVD 1/12/2012 2:28 PM File folder
. Carlson2012_ARDMenuFix 1/12/2012 2:28 PM File folder

. Carlson2012Manual 1/12/2012 2:28 PM File folder

=
b Iestaligtionlnstructions 1/12/2012 2:28 PM File folder
1@ 1/12/2012 2:28 PM AutoCAD Custor

4 [T | 3

FiIegame:( m} '(,I Qpen ]5]

Files of type: |Customization files (*.cubx) ][ Cancel
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e Note that the path to ‘AecCo.cuix’ is shown.
e Click Load to complete the menu load.
- .
My Load/Unload Customizations .

Loaded Customization Groups:
AcAD ]
ACADIZTE
ACADBASE
CARLSON
EXFRESS
MAPCLASSIC
Y ——
( )
File Name: m
> SR <<<< Browse...

[ Close ][ Help ]

.

e Note that ‘AUTOCADRASTERDESIGN’ is now included in the list of ‘Loaded Customization
Groups’.

e Click Close to exit the ‘cuiload’ routine.

";'.,' Load/Unload Customizations u

Loaded Customization Groups:
ACAD

Unload
frecton
ACADBASE
S
CARLSON
EXPRESS
MAPCLASSIC

Load
File Mame:
EMecCo cuie

Browse...

Close Help
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e Go to the ‘File’ menu dropdown and click Exit to close the program (Click No when prompted

to save the drawing file).
e This completes installation and initial setup of Carlson Software 2012.

Format Tools

Ctrl+M
e, N@G\’: ﬁﬁ'gfﬁéﬁa*l-'ubllsn Lretalls...
Drawing Utilities *
Curre Send...
= | [ Drawing Properties...
9 Drawing History
Data
Exit Ctrl+Q
=

Latest Program Version / Updates

e The latest program full version and updates / patches can be accessed / downloaded at any time
by visiting http://update.carlsonsw.com/updates.php; you will need to enter the Carlson software
serial number to ‘Lookup Download’ and access the available update file(s).

‘& Carlson Software Product Downloads - Windows Intemet Explor
et —

http:/fupdate.carlsonsw.com/updates.php

|I| File Edit View Favorites Tools Help
74 Favorites =

| Carlson Software Product Downloads

& - - [ @ v Page~ Safety > Tools~ G

Carlson Software is dedicated to
providing the finest software to Land

A Surveyors, Civil Engineers, Mining
g Engineers, and Land Development

Professionals

Welcome to the Carlson Software product download page.

Select product you are looking for Carlson Survey/Civil/Mining/Takeoff for CAD - Show Files

Enter Serial Number to Find Right Download: Lookup Dewnload

Copyright ©® 2012 Carlson Softwars. All Rights Reserved
page |ast updated: January 31, 2012


http://update.carlsonsw.com/updates.php
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Accessing Windows Environment Variables

Certain environment variables must be set to allow Autodesk products to obtain a license from the TIPS
license server. Specific information on the necessary variables is listed in the software distribution letter
mailed to your TIPS contact.

To access the environment variables:

e Navigate to Start Menu -> Control Panel -> System to open the ‘System Properties’ window
(In Windows 7, Start Menu -> Control Panel -> System->Advanced System Settings).

e On the ‘System Properties’ window, select the ‘Advanced’ tab and click Environment
Variables.

Windows XP Windows 7 o=

System Properties

- .

5 —
System Restore Automatic Updates e [ Computer Name [ Hardw&‘ Advanced Dyslem Protection ‘ Remote‘
General | ComputerName | Hardware Advanced ——

‘You must be logged on as an Administrator to make most of these changes.
You must be logged on as an Administrator to make most of these changes.

Performance
Performance Visual effects, processor scheduling, memory usage, and virtual memory
Visual effects, processor scheduling, memory usage, and virtual memoty
: User Profiles
User Profies L Desktop settings related to your logon
Desktop settings related to your logon
e [ settngs.. | | |

Startup and Recovery

Startup and Recover
2 | System startup, system failure, and debugging information

System startup, system failure, and debugging information

C Environment Variables ! DEnot Repoiting < Environment Variables... | D)

=

e The lower half of the resulting Environment Variables dialog box is the area where you can add
new variables or edit existing ones.

r ™
Environment Variables M

User variables for

Variable Value
TEMP
T™MP
New... | [ Edit.. ][ pekte
System variables
Variable Value Il
I
ADSKFLEX_LICENSE_FILE -
ARCGIS_LICENSE_FILE
ARCGISHOME i
4 [ | +
New.. |[ Edt.. |[ Deete |

[ OK ][ Cancel ]
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Installation / Update Contacts

If you have any installation or update questions or difficulties, contact Tom Mastaller at (412) 937-2108
or TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Stefanie Self at (412) 937-2105 or
SSELF@OSMRE.GOV.

Additional information (e.g., most recent installation instructions and installation FAQSs) is available on
the TIPS CAD Software webpage http://www.tips.osmre.gov/Software/cad/CAD.shtml.

TIPS HOME | SITE INDEX | SITEMAP |

TECHNICAL INNOVATION AND PROFESSIONAL SERVICES
L About TIPS Training Software Geospatial Newsroom ContactUs

SOFTWARE / SUPPORT TEAMS / CAD

* l

ALERT: |

TIPS will only support three versions of Autodesk software prior to the 2011 release. If |
you are using versions previous to 2008, you must upgrade to versions 2008 or newer. |
Please contact your TIPS Contact or Service Manager to obtain the latest version.

Team Members
Software
Installation
Training

FAQ
Resources

New Course Offering in 2011

TIPS will be offering a new course, "CAD 400: Bridging the CAD and GIS Gap in the SMCRA
Workflow." The purpose of this course is to assist personnel in integrating both CAD and GIS
processes into SMCRA workflows. Exercises will include use of Title IV and V data to show
mechanisms of interoperability between CAD and GIS. Check out the TIPS and NTTP class survey
for this new.
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